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General

The PAPAGENO MAPI Connector provides a connection between Outlook and PAPAGENO.

It is installed on a user machine for Outlook. Text in the Outlook sending window as well as attachment 
documents sent to a fax address are converted to the fax format and passed to PAPAGENO. 
It provides features for message management (fax, SMS, voice mail).

The PAPAGENO MAPI Connector is compatible with Outlook only up to version 2010 (32-bit)! 

The virtual printer Fax-MAPI-Printer is part of the PAPAGENO MAPI connector, but it can be installed 
separately. It converts documents from any Windows applications into fax format (*.tif).
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The Fax MAPI Printer transfers the converted documents to Outlook or the PAPAGENO client  
comFAX/Win, depending on the setting during the installation. comFAX/Win has a direct connection 
to the PAPAGENO server; Outlook sends faxes to PAPAGENO via Mailserver/SMTP gateway.

MAPI Connector and Fax MAPI Printer Convert the following Formats:

All output formats that are common today: Microsoft Office formats (Word, Excel, etc.) as well as all 
formats supported by the OLE interface. Everything you can print from the Windows PC can also be 
converted to the fax format. 

User Manual for Sending Faxes from Office Applications and Outlook:
www.vipcomag.de - Downloads - PAPAGENO - Manuals - Clients - Fax User („PAPAGENO Fax 
Users Manual Outlook 2010 and higher“).
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A. Install MAPI Connector and Fax 
MAPI Printer   
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A

1. How to Install the PAPAGENO MAPI Connector

In the control panel set the User Account Control to Low.

Check with your administrator where the installation files for the PAPAGENO MAPI connector are 
stored on the network
or:
download the current version of the PAPAGENO MAPI Connector from our homepage  
 (www.vipcomag.de - Download - PAPAGENO - Software - MAPI-Connector).
Open the MAPI directory.
Start Setup.exe.
The following window opens

Under Please select your language  select the desired language 

Under Send via: select Mail

Under MAPI Installation you can choose to install only the Fax MAPI Printer (Printer) or 
the entire MAPIConnector (Connector and Printer).
Select Connector and Printer 
Confirm with OK.

The installation is complete. The PAPAGENO MAPI Connector can be integrated in Outlook now. 
(See below Part B, Chapter 1. „Include the PAPAGENO MAPI Connector in Outlook”, page15).
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2. How to Install the Fax MAPI Printer  

The Fax MAPI Printer is part of the PAPAGENO MAPI Connector, but can be installed separately.   
In the control panel set User Account Control to Low.

Download the current version of the PAPAGENO MAPI Connector from our homepage  
 (www.vipcomag.de - Download - PAPAGENO - Software - MAPI-Connector).

You can install the printer via setup.exe or a setup command.
In either case, select the client to which the converted documents will pass (Outlook - to Version 
2010 (32-bit) or comFAX/Win). For comFAX/Win, specify the user's PAPAGENO name and ALPHA 
host.

Installing Printer via setup.exe 
Change to the  MAPI directory. 
Start setup.exe.
The following window opens:

Under Please select your language select the desired language.

Under Send via select whether documents converted from the MAPI printer to * .tif format are sent 
- to Outlook  (Mail)  
- or to PAPAGENO comFAX/Win (Papageno) 

!NOTE! If you are using the 64-bit version of Outlook you must set the Papageno option.
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A

Select the desired option.
Under MAPI Installation select Printer

If you have selected Papageno the following window appears:

In the User-field enter the name of the PAPAGENO user for which the MAPI connector is instal-
led, in the  Alphahost-field the name of the responsible ALPHA host.

Click OK.
The Fax MAPI Printer will be installed as a virtuell printer.

To Install the Printer via a Setup Command

Open a DOS input window und navigate to the MAPI directory.

The Fax MAPI Printer setup command has the following syntax:
setup mode [alphahost=host user=name] [debug]

mode:  printerger printereng or printerfra 
for the german, english or french version 

If alphahost und user are spezified, the printer sends the converted documents to the PAPAGENO 
client, otherwise to Outlook.

Enter the setup command.

The Fax MAPI Printer is installed as a virtuell printer.
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Examples:
Setup printerger 
installs the german Fax MAPI Printer. Office documents will be converted into tif format and forwarded 
to Outlook.

Setup printerger alphahost=Faxserver_C user=peter 
installs the german Fax MAPI Printer. Office documents will be converted into tif format and forwarded 
to the windows client of the user „Peter“, ALPHA host „Faxserver_C“ .
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B. Installation and Integration
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 B. Installation and Integration B

1. Include the PAPAGENO MAPI Connector in Outlook 

Now you include the PAPAGENO MAPI Connector via an user profile in Outlook.

To do this you need:
 short name of the PAPAGENO user for which the Outlook profile with MAPI Connector is to be set 

the transmission protocol  (TCP/IP or UDP) 

and the name of the PAPAGENO server computer.

Note: If you are installing an update version of the PAPAGENO MAPI Connector, you do not need 
to include the new version in the mail client. 

Set the MAPI Connector as the New Server Type

At the end of this process, the Fax-Server-Properties window opens, where you enter the 
data for the new profile.

The steps for the current and older versions of Outlook are described below. 

Description for newer versions of Outlook 

Open the window Account settings. 
Select the E-mail tab.

Highlight PAPAGENO MAPI Connector and click on New....
The New Account window will open.
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Select Others and then PAPAGENO MAPI connector.
Click Continue.
The Fax Server Properties window will open. Here you can login to PAPAGENO and fix the 
desired features (see below under „Enter Login Data”, page 17). 

Description for Outlook 2002

In the menu File Options - click on Account settings. 
The E-Mail account window opens.
Select Add a new E-Mail account and click on Continue.
Select Additional server types and click on Continue.
Select PAPAGENO MAPI Connector and click on Continue.
The Services window opens.
Select PAPAGENO MAPI Connector and click the Add button.
In the window Add service to profile the  PAPAGENO MAPI Connector is highlighted. 
Confirm the selection with OK.
Click on the button Properties to open the window Fax Server Properties.
Here you can log in to PAPAGENO and fix the desired features  
(see below under „Enter Login Data”, page 17). 

Description for Outlook 2000

In the Outlook menu Tools select Services.
or, without opening Outlook:
In the control panel select Mail.
The Services window opens
Select PAPAGENO MAPI Connector and click the Add button.
In the window Add service to profile the  PAPAGENO MAPI Connector is highlighted. 
Confirm the selection with OK.
Click on the button Properties to open the window Fax Server Properties.
Here you can log in to PAPAGENO and fix the desired features.  
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 B. Installation and Integration B

Enter Login Data

Select the Login tab:

In the Host field type the name of the computer on which the PAPAGENO server is installed.
In the User field enter your PAPAGENO user name.

In the Password field, you can enter an personal password to protect your messages. If you want 
to have telephone access to your faxes, emails and sms messages, enter a number.
Enter a password or a number. 

If you forget your password, your administrator can give you a new one.

In the Transport box select the transport route via  UDP or TCP. 
Click Apply and close the window with OK. 

Save the PAPAGENO Login

To save the newly created profile and set other properties, you must restart Outlook.
Close all windows.
Restart Outlook. 
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 B. Installation and Integration B

2. Send a Test Fax 

To test whether the PAPAGENO MAPI connector has been successfully installed and configured, 
send a test fax.

Open a New Message window. 

Write a short text.
In the  To box enter a fax number in the following syntax:.  
[FAX:faxnumber] (including square brackets) 
Example: [FAX:123456]
Click on Send.
The  PAPAGENO MAPI connector should now send the fax to the specified number. The text you 
have written is converted to the fax format  (.tif).
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 C. Sending Messages C

1. To Create Messages

Creating a Fax 

You have several options for creating a document that you send as a fax from the mail client.

Creating a document in a word processor

Normally, you create a fax document in your usual word processor. You can send the document from 
the Word Processor, or insert it as an attachment in the New Message window, just like when you 
send an e-mail. When sending, the pages of the document are converted to the fax format (.tif) .

Writing a message in a mail client 

As in an e-mail, you can write text in the New Message window and format it if necessary. When you 
send this message to a fax address, the PAPAGENO MAPI connector internally converts the text to 
fax format  (.tif) . 

Scanning a document 

Make shure that  
- the scanner is locally connected to a Windows PC  
- the scanner software is installed 
- the FAX MAPI Printer is installed with the PAPAGENO MAPI connector

Install the  FAX MAPI Printer in your scanner software.

When you scan a document, send it to the FAX MAPI Printer.
Insert the fax address of the recipient
or

insert your own fax address 
Syntax see below „The following figure shows a mailing window with an attachment and associated 
text”, page 29
In this case, you will receive the scanned document as a Tif attachment in a mail. 

Creating an SMS

Open a send window and write your text in the same way as for an e-mail. 

The number of characters you may use is told by your administrator.

Text in the “subject” line does not arrive.

Note: Text in „Subject“ is not included.
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2. How to Administer Fax Numbers in Outlook

New Outlook versions

Via contacts you can add the fax, SMS and voice mail numbers to the entry of an email recipient.

Depending on which entry you select, the message is sent as an e-mail, fax to the fax address, SMS 
to the hand-held number, or as a voice mail to the receiver's telephone number.

Note: User groups can only be used in PAPAGENO phonebooks. 

Older Outlook versions

In older versions of Outlook you can manage the numbers and addresses of the recipients in your 
personal address book. 

In the address book, open the New Entry  window via File - New entry.
Select Personal Address Book and Other Address. 
Click OK.
A Window Properties of... will open. 

In the Display field enter the name of the fax recipient. 
(This name appears in the send window).
In the E-mail address field enter the recipients fax, voice or SMS number (with or without prefix 
code). 
In the E-mail type field enter FAX or VOICE or SMS.
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 C. Sending Messages C

3. PAPAGENO Telephone Books

In PAPAGENO phonebooks you can only enter fax addresses.

After installing the PAPAGENO MAPI connector, you have access to all PAPAGENO phonebooks for 
which you have user rights. However, you can also create new phone books using a mail client. 

 How to create a new telephone book:

In the Tool menu click Address book 
In the Address book window click File - New Entry.
In the In pulldown menu select phone books.
Select PAPAGENO telephone book in the type of entry field and click OK.

Enter a name for the new telephone book and click Apply.
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To assign access rights  

You can assign the rights „read only“, „change“, „delete“, etc. to a group or to other PAPAGENO 
users („others“) to the new telefon book. The „owner“ who has created the telephone book has all 
rights.

This are the rights:

Read: read only (list of recipients can only be viewed and exported))
Use: usage allowed (receivers can be selected for sending)
Add: adding new recipients allowed 
Change: changing entries allowed
Delete: deleting entries allowed
Rights: changing access rights and deleting the telefon book is allowed 

Note: If you grant access rights, it is recommended to always assign the "Read" access right.

For example, if you assign the right „se“ to a phone book but does not have the "read" right, the users 
you are authorized to use can use the phone book entries, but you can not view the phone book. 
In this case, an authorized PAPAGENO user can enter a recipient name from this telephone book 
which he does not see as a recipient when sending a document. The receiver's telephone number 
is then automatically determined.

To assign phone book rights to a group or an user:

Select the phone book in the Address Book window and highlight it.
In the File menu click Properties.
Select the Other’s Rights or the Group Rights tab. 

In the pulldown menu select the user respectively the group.
Assign the rights and click Apply.
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 C. Sending Messages C

To Enter Recipients in the PAPAGENO Telephone Book

To enter a new recipient:

Select the phone book in the Address Book window.
In the File menu click New Entry.

In the  Put this entry pulldown menu select the phone book in which you want to enter a new 
recipient.

In the Select the Entry Type field highlight PAPAGENO FAX/Telex recipient.

Click OK.
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Enter the name of the recipient (Maximum of 30 characters) 

Enter the fax number. 
You can use spaces, "/" and "-" for better legibility. The number (s) to be used for the outside line 
may not be entered.

CAUTION: Do not enter the TSI. This number will automatically be entered as soon as the first fax 
is sent to the recipient.

Select the Connection.

Enter the device type Fax.

Confirm with OK.

How to Enter Recipient Groups

To enter a recipient group (Older Outlook versions):

In the Address book click File - New Entry
In the Put this entry pulldown menu select Recipient groups.
In the Select the Entry Type field highlight PAPAGENO Recipient Group.

Enter a name for the new group.
Assign recipients to the group.
If required assign rights (see page 26).
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 C. Sending Messages C

4. Sending Messages

How to Send a Fax from Outlook

The following figure shows a mailing window with an attachment and associated text

Text and appendix will be dispatched as fax pages.

Enter the address in the format  
[FAX:phone number],  
e. g.: [FAX:08954750200]
To enter several recipients, seperate them by a „ ; “, e. g. [FAX:123456];[FAX:654321].
Send options see page 30.

How to Send a Fax From an Application

In an Windows Application (e. g. Word) in the menu File select Send to... email recipient
or 

in the menu File - Print select the FAX MAPI Printer.
A send window will open. The document is attached. You can enter a fax address (see above).
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How to Set Send Options 

You can use send options (send time or resolution) when selecting a recipient from the „Common“ 
or a PAPAGENO address book or while entering a new recipient. 

Description for older Outlook Versions:

Highlight a recipient in your address book. 
Via the button Send options open the window  Send options.

To send the fax immediately:

Keep the default normal .

To send the fax today:

Keep the default Normal tariff and enter the requested send time.  
Example: 10:30 or 15 for 15 o’clock.

To send the fax on a certain day and time

Keep the default normal .
Enter date and time.

To use the cheap rate

Enter night. 
Via the recipient’s address PAPAGENO establishes the most low-price send time at the earliest 
possible date. At this time PAPAGENO starts the first send trial. 
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 C. Sending Messages C

How to set redialling

Enter the number of rediallings in case of unsuccessful attempts (recipient is busy), at most 9. 

How to set the resolution 

Set the resolution via the options as saved, normal or fine.
as saved means the resolution of the document pages. So document pages might be dispatched 
in different resolutions.

Note! Some fax machines can not receive such documents.

Save the send options

Save the send options and send the fax.
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How to View the Outgoing Messages and the Logbook 

Copies of outgoing messages will be entered in the PAPAGENO folder Outbox or in the Outlook 
folder Sent Objects.

Each outgoing message includes an attachment (.tif file or voice file) and a logbook.

Note: The outgoing message logbook exists only in the PAPAGENO folder Outbox.

A document appears italic in the Outbox folder, if it is dispatched faultly.

To change an outgoing document make a copy in the desk folder. 

Take a look at the logbook:

Click on the icon logbook in the outgoing document.

The logbook contains detailled information about the recipient identification, the desired send time, 
the transmission protocol, the real sent time, faults and so on.

Via File, Edit and Search you can save the logbook and search for specific entries.
32 PAPAGENO MAPI Connector and FAX MAPI Printer



D. Setting Options 

1. How to Save Debug Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35

2. How to Set the Sequence of the Transport Services  . . . . . . . . . . . . . . . . . . . . . . . .36

3. How to Set the Sequence of Address Books. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37

4. How to Create a Cover Sheet for Faxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38

5. How to Set an Alias  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

6. How to Set Server Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43

7. How to Change the Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44

8. How to Log on to a Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45

9. Complete Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46
Version 5.9 33



 

34 PAPAGENO MAPI Connector and FAX MAPI Printer



 D. Setting Options D

1. How to Save Debug Information

Open the  Fax Server Properties window  (see page 15).

You can set important program-internal information to be collected. These are stored in a file, which 
can be sent to VIPcom GmbH support (address see imprint) if problems occur.

Select the Debug tab.

Enter name and path to the debug file.  

The following options are available:

Select the desired option and click Apply.
Close the Fax Server Properties window with OK.

Error information about errors in the program sequence.

Warning warning messages

Debug runtime events

Call function calls

Property access object accesses.
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2. How to Set the Sequence of the Transport Services 

You can set which service should be used by default when sending messages. If you send many 
faxes, it is recommended to put the PAPAGENO MAPI connector first.

Note that faxes, voice mails and SMS messages can only be sent via the PAPAGENO MAPI 
connector.

Description for Outlook 2010

Open the window Account settings..

 
If more than one transport service is displayed:

Use the up and down arrows to set the service at the top, which is to be used by default when sen-
ding messages.

Description for Outlook 2000

Open the Services window via Extras and select the transport tab..

Use the up and down arrows to set the service at the top, which is to be used by default when sen-
ding messages.
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3. How to Set the Sequence of Address Books

Outlook 2000:

Open the  Services vwindow via Tools and select the Addressing tab  

 Outlook 2007:

In the menu Tools open the window Address book.
Open the Address book and select Options

You can set the address book to be displayed first when you send a message using the To button.

In the lower list field, you can specify in which address book first the recipient address is to be searched 
for. 
For a fax number from the address book, which is the first one, you can ignore the syntax [FAX: 
fax number]. You specify only the fax number in the send window.

Select the default address book in the Show this addresses first list. 
Via Add select the address books in which recipients addresses can be found.
Sequence the address books. 

Click Apply and then OK.
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4. How to Create a Cover Sheet for Faxes

The PAPAGENO MAPI connector allows you to generate a cover sheet. This cover sheet is a form 
in which placeholders, for example for recipient fax number, name of the sender, date, etc., are 
entered. You can specify that the cover sheet is sent as the first page of a fax. The current data are 
entered automatically each time.

The PAPAGENO MAPI-Connector allows you to generate a cover sheet which is a form with 
placeholders, for example for recipient fax number, name of the sender, date, etc. . You can specify 
that the cover sheet is sent as the first page of a fax. The current data are entered automatically each 
time.

Note! The design possibilities are very limited because the cover sheet has to be formatted 
in the mail window. 
If you rarely need a cover sheet, you have the possibility to create it in a graphics program 
as desired and then manually insert it as the first page of a fax.

Open the  Fax Server Properties window  (see page 15).
Select the cover page tab. 

Specify which cover sheet you want to apply, a personal cover sheet (PERSONALCOVER) or a 
company cover sheet (COMPANYCOVER)

Click Apply and close the window with Ok.

To Generate a Cover Page:

Open a  New Message window in Outlook.
In the To line, specify which cover sheet you want to apply.

Note:  A „company“ cover you can only generate  as user comfax.

Write in the To line:  
[FAX:PERSONALCOVER] or  
[FAX:COMPANYCOVER] 
Don’ forget the square brackets!
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To Design a Form

Design the cover sheet form in the New Message window.

Note that there are few formatting options.

Placeholders:

Example:

@from Name of the sender as entered in the MAPI connector

@fromcf Name of the sender as entered in the fax server

@frommail E-mail address of the sender as entered in the MAPI-Connector

@frommailcf E-mail address of the sender as entered in the fax server

@to Recipient's name

@tonumber Recipient's number

@pages Number of pages, including cover sheet

@pagesdoc Number of pages, exclusive cover sheet

@date Currennt date

@time Current time (sending the document in the format of the local computer)

@subject Subject 

                                                                 @date

From:     @from

To:       @to

Number of pages: @pagesdoc

Subject: @subject
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On the Format menu, type Rich Text in the New Message window. 
Design the cover sheet using the placeholders.

Format text

Format the text of the cover sheet. Use the appropriate dialog boxes or buttons to determine the font, 
size, and section.
When formatting a placeholder, note that you must mark the entire placeholder (@ sign and 
letters) and then change it! If you do not format the @ sign, this leads to errors.  

If the cover page is generated in a Windows application:

Copy the entire formatted text.
Open the New Message window that has already been created.
In the To line is: [FAX: PERSONALCOVER] or [FAX: COMPANYCOVER]).

On the Format menu, type Rich Text in the New Message window. 
Paste the copied form text directly into the window using the Edit - Paste menu.
If necessary, reformat the text.

Be sure to insert the text with the placeholders as text, not as a graphic! 

Insert Graphics

You can also insert graphics, such as a company logo, into the cover sheet.

Paste the copied graphic in the New message window.

Complete Cover Sheet Creating

After finishing the creation of the cover page:

Click Send.
The cover page will be stored in the Desk folder. The subject is „Personal Cover“ . 

To Use the Cover Sheet

If you want to send a fax with a cover sheet:

Open the Fax Server Properties window.
Select the Cover Page tab.
Set which cover sheet you want to use (personal or company), confirm with Apply and close the 
windows with  OK.
Restart Outlook.  
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Example Cover Page:

From:

To:

Number of pages :

Subject:

11-11-2017

Vipcom

Enjoy Food Catering Service

3

Booking
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5. How to Set an Alias 

Open the  Fax Server Properties window  (see page 15).

Click on the Button more... 

In the Fax Server Properties (Online) window select the Alias tab. .

In the pull-down menu select the desired substitute to whom the faxes sent to you should be sent.

If you would like to receive a copy of the fax sent to the representative:

Activate keep copy.
If you do not do so, you will receive no more faxes!

 Click Apply and close the window with OK. 
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6. How to Set Server Actions

Open the  Fax Server Properties window  (see page 15).

Click on the Button more... 

In the  Fax Server Properties (Online) window select the Actions tab.
Here you can set the type of notification (mail, print, light or audio signal) for incoming and outgoing 
faxes as well as when errors occur..

In order to be informed by light or sound signal, it is necessary that you have the appropriate telephone 
system and that your PAPAGENO administrator has made the appropriate settings.

To be notified via mail your mail address must have been entered in the PAPAGENO administration 
program.

If there are already entered actions and you want to change them arrange that with your administrator.

Activate the desired settings.  
Click on Apply and close the window with OK. 
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7. How to Change the Password 

Open the  Fax Server Properties window  (see page 15).

Click on the Button more... 

In the Fax Server Properties (Online) window  select the New Password tab. 

If you want to retrieve your messages by telephone, enter a number (eg 123) as the password. This 
sequence of numbers is then also your PIN code, which allows you to access your faxes, voice mails, 
SMS messages and e-mails over a telephone.

If you want to request your messages via phone enter numerics only. In addition this numerical 
sequence is your pincode to access your faxes, voice mails, SMS messages and emails via phone.

In the New Password field, type your new password and retype the entry in the Repetition field.

In the New password field, enter the new password.
Re-enter it in the Repeat field.
Click Apply and close the window with OK. 
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8. How to Log on to a Group 

Sometimes it is helpful if several users, eg a department, can access a common mailbox. In this case, 
faxes sent to a specific address are accessible to multiple users.

If you are member of a group you receive all faxes that are addressed to the group.

Open the  Fax Server Properties window  (see page 15).
Click on the Button more... 

In the  Fax Server Properties (Online) window select the Dispatch user tab.

In the pulldown menu User select the group.
Enter your password in the password field.
Click Apply and close the window with OK. 
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9. Complete Settings

To accept the changes:

Quit Outlook and then restart it.. 
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